COPYRIGHT NOTICE

© Labcenter Electronics Ltd 1990-2007. All Rights Reserved.

The PROTEUS software programs (ISIS, PROSPICE and ARES) and their associated library files, data files and documentation are copyright © Labcenter Electronics Ltd. All rights reserved. You have bought a licence to use the software on one machine at any one time; you do not own the software. Unauthorized copying, lending, or re-distribution of the software or documentation in any manner constitutes breach of copyright. Software piracy is theft.

PROSPICE incorporates source code from Berkeley SPICE3F5 which is copyright © Regents of Berkeley University. Manufacturer’s SPICE models included with the software are copyright of their respective originators.

WARNING

You may make a single copy of the software for backup purposes. However, you are warned that the software contains an encrypted serialization system. Any given copy of the software is therefore traceable to the master disk supplied with your licence.

PROTEUS also contains special code that will prevent more that one copy using a particular licence key on a network at any given time. Therefore, you must purchase a licence key for each copy that you want to run simultaneously.

DISCLAIMER

No warranties of any kind are made with respect to the contents of this software package, nor its fitness for any particular purpose. Neither Labcenter Electronics Ltd nor any of its employees or sub-contractors shall be liable for errors in the software, component libraries, simulator models or documentation, or for any direct, indirect or consequential damages or financial losses arising from the use of the package.

Users are particularly reminded that successful simulation of a design with the PROSPICE simulator does not prove conclusively that it will work when manufactured. It is always best to make a one off prototype before having large numbers of boards produced.

Manufacturers’ SPICE models included with PROSPICE are supplied on an ‘as-is’ basis and neither Labcenter nor their originators make any warranty whatsoever as to their accuracy or functionality.
INTRODUCTION

The aim of this guide is to take you through the process of entering a circuit of modest complexity in order to familiarise you with the techniques required to drive ISIS. The tutorial starts with the easiest topics such as placing and wiring up components, and then moves on to make use of the more sophisticated editing facilities, such as creating new library parts.

For those who want to see something quickly, ISISTUT.DSN contains the completed tutorial circuit. This and other sample designs are installed to the SAMPLES directory.

It is important to note that a full reference manual is also included with the software and can be accessed from the ISIS Help command on the Help Menu in ISIS. Whereas this documentation provides a practical introduction to the software, the reference manual provides complete coverage of software functionality, including detailed discussion on more advanced functionality that is not covered in this guide.

You may also find our web based support forums useful for general Proteus enquiries and discussion: http://support.labcenter.co.uk

Finally, if you still have questions or problems after consulting the reference manual please contact your local authorized distributor for technical support or mail us directly at support@labcenter.com quoting your customer number in the subject line of the email.
A GUIDED TOUR OF THE ISIS EDITOR

We shall assume at this point that you have installed the package, and that the current directory is some convenient work area on your hard disk.

To start the ISIS program, click on the Start button and select Programs, Proteus 7 Professional and then the ISIS 7 Professional option. The ISIS schematic editor will then load and run. Along the top of the screen is the Menu Bar.

The largest area of the screen is called the Editing Window, and it acts as a window on the drawing - this is where you will place and wire-up components. The smaller area at the top left of the screen is called the Overview Window. In normal use the Overview Window displays, as its name suggests, an overview of the entire drawing - the blue box shows the edge of the current sheet and the green box the area of the sheet currently displayed in the Editing Window. However, when a new object is selected from the Object Selector the Overview Window is used to preview the selected object - this is discussed later.

Navigation of the view displayed in the Editing Window takes two forms; adjusting the scale of the drawing (zooming) and adjusting the area of the drawing displayed (panning). These techniques are somewhat intertwined and are discussed in more detail below:

**Zooming**

There are several ways to zoom in and out of areas of the schematic:

- Point the mouse where you want to zoom in and out of and roll the middle mouse button (roll forwards to zoom in and backwards to zoom out).
- Point the mouse where you want to zoom in or out of and press the F6 or F7 keys respectively.
- Hold the Shift key down and drag out a box with the left mouse button around the area you want to zoom in to. We call this Shift Zoom.
- Use the Zoom In, Zoom Out, Zoom All or Zoom Area icons on the toolbar.

The F8 key can be used at any time to display the whole drawing.

The Shift Zoom and the middle mouse zoom techniques can also be used over the Overview Window. That is, you can position the mouse over the Overview Window and either roll the middle mouse button or use Shift Zoom to navigate in or out of an area of the schematic.

**Panning**

As with zooming, there are a number of options for panning across the editing window.

- Click on the middle mouse button to enter track pan mode. This puts ISIS in a mode where the entire sheet is picked up and will move as you move the mouse. The track pan cursor will indicate when you have entered this mode. Left click the mouse again to exit track pan mode.
- To simply 'pan' the Editing Window up, down, left or right, position the mouse pointer over the desired part of the Editing Window and press the F5 key.
- Hold the Shift key down and bump the mouse against the edges of the Editing Window to pan up, down, left or right. We call this Shift Pan.
• Should you want to move the Editing Window to a completely different part of the drawing, the quickest method is to simply point at the centre of the new area on the Overview Window and click left.

• Use the Pan Icon on the toolbar.

Note that when using the track pan method above you can also zoom in and out by rolling the mouse wheel. So, click the middle mouse button to pick up the sheet and move the sheet by moving the mouse and zoom the sheet by rolling the middle mouse button. Left click to ‘drop’ the sheet and exit track pan mode.

It is well worth spending a few moments familiarising yourself with navigation in ISIS - it is after all one of the most common operations you will perform. In particular, learning to use the middle mouse button both for track pan and for zooming will save you time during schematic design.

A grid of dots can be displayed in the Editing Window as a visual aid using the Grid command on the View menu, by pressing ‘G’, or by clicking the Grid Icon on the toolbar. The grid helps in lining up components and wires and is less intimidating than a blank screen. If you find it hard to see the grid dots, either adjust the contrast on your monitor slightly (by default the grid dots are displayed in light grey) or change their colour with the Set Design Defaults command on the Template menu.

Below the Overview Window is the Object Selector (sometimes known as a 'parts bin') which you use to select devices, symbols and other library objects. We’ll familiarise ourselves further with using the Object Selector later.

Finally, at the bottom of the screen is the co-ordinate display, which reads out the co-ordinates of the mouse pointer when appropriate. These co-ordinates are in 1 thou units and the origin is in the centre of the drawing.

The co-ordinate display in ISIS.

Note that ISIS allows you to reposition all the icon toolbars as well as move/resize the Object Selector/Overview Window. Do be aware however, that this documentation refers to all the rebars and windows in their default locations.

BASIC SCHEMATIC ENTRY

The circuit we are going to draw is shown below. It may look quite a lot to do, but some parts of it are similar (the four op-amp filters to be precise) which will provide opportunity to use the block copying facilities.
Visual Aids to Design

ISIS is designed to be as user friendly as possible and provides two main ways to help you see what is happening during the design process – objects are encircled with a dashed line or when the mouse is over them and mouse cursors will change according to function. Essentially, the context-highlighting scheme tells you which object the mouse is over (the ‘hot’ object) and the mouse cursor tells you what will happen when you left click the mouse on that object. While extremely intuitive, a summary of cursors used, together with their actions, is provided overleaf:

- **Standard Cursor** – used in selection mode when not over a ‘hot’ object.
- **Placement Cursor** – placement mode will be entered on left click.
- **Hot placement cursor for wires** - a wire will either start (or stop if currently placing a wire) when the mouse is left clicked.
- **Hot placement cursor for buses** - a bus will either start (or stop if currently placing a wire) when the mouse is left clicked.
- **Object under the mouse will be selected on left click.**
- **The object under the mouse can be moved by left depressing the mouse and dragging it into the desired position.**
- **The wire segment can be dragged by left depressing the mouse and dragging it to the desired position.**
- **Left clicking the mouse will assign the specified property to the object (used with the Property Assignment Tool).**

We will see more of the different cursor types throughout the course of the tutorial.

**Picking Components into the Schematic**

The first thing we need to do is to get the parts from the libraries that we need in our schematic.

You can select parts from the library in one of two ways:

1. Click on the P button at the top left of the **Object Selector** as shown below. You can also use the Browse Library icon on the keyboard shortcut for this command (by default this is the P key on the keyboard).

   ![Picking components from the Object Selector.](image1)

2. Right click the mouse on an empty area of the schematic and select Place – Component - From Libraries from the resulting context menu as shown below:

   ![Picking components from the Context Menu.](image2)

Either of these two methods will cause the Device Library Browser dialogue form to appear.

The next stage is to find the desired components in the libraries. You can search the library for components in a number of ways. In the case of parts where you know the part name its usually best to start the search with that. Try entering 741 into the Keywords field. There are a lot of parts with 741 in their name or description, but you can refine the results to a more reasonable set by selecting the Operational Amplifiers category, as shown overleaf:
You can customize the information displayed in the Library Browser’s results list by right clicking the mouse on the results list. The context menu provides you with options to display Categories, Sub-Categories, Manufacturer and Library alongside each result.

Finally, double click on the line in the results list to pick the ‘741’ part into the design. The part will then appear in the Object Selector as shown below:

The Object Selector containing a 741 op-amp

Having successfully selected the ‘741’ part we also need some resistors. Specifically, we will want 1k, 10k, 12k, 15k, 56k, 68k and 100k resistors. This will give us a chance to familiarise ourselves with the various search mechanisms available via the Browse Libraries dialogue form.

One highly useful technique is to search for a part via relevant keywords. Think of this like entering keywords in the Google™ internet search engine – you type in a series of relevant keywords and you get a list of matching results. Try this now by changing the keyword text to be ‘12k resistor’. You should see a list of results that all contain the included search terms. For our purposes the ‘MINRES12K’ component will suffice - select this into the library in the same way as before.

We could of course repeat this process for the remaining resistors but instead we’ll cover some of the other search techniques available. It’s a reasonable assumption that a logical naming convention will be applied across the libraries. If we change the keyword text to be ‘MINRES1’ therefore we will filter the result set such that you can now pick the 1k, 10k, 15k and 100k resistors from the results list.

Another, more generic method of finding library parts is to search through the indexing system. This is particularly useful if you are browsing for a part and you are unsure of the part name or a suitable description for the part. Try this now by deleting the text in the keywords field and selecting the ‘Resistors’ Category. Scrolling down the results list you should be able to see the MINRES resistors. Select the 56k and 68k resistors onto the design in the normal way and close the dialogue form.

It is worth noting that you can use these techniques in tandem. For example, you could have entered ‘1k’ into the description field and then selected the Resistors category to filter the result down to all resistors containing 1k in their descriptions. While the above explanation may seem somewhat involved you will quickly find the most suitable search mechanism for you and selecting parts will become second nature. Now that we have our basic schematic building blocks, we can move on and actually place them on the design.
Placing Components onto the Schematic

Having selected the parts we need the next thing is to actually place them on the drawing area – the *Editing Window*. The easiest place to start is by doing the buffer circuit shown at the top left of the tutorial circuit. This is reproduced in more detail below:

![A close up view of the initial section of circuitry to be drawn.](image)

Make sure that you are in component mode (i.e. that the *Component Icon* is selected) and start by clicking the mouse on the 741 in the Object Selector. You should see that the Overview Window above the selector changes to display a preview of the selected device. The screenshots below show the state of the Object Selector and the Overview Window after selection of the 741 part.

![Object Selector](image) ![Overview Window](image)

> Not only does the *Overview Window* show a preview of the device but it does so at the current orientation of the device. As you rotate or mirror the part (via the Rotation and/or Mirror icons), the device is redrawn to preview the new orientation. The preview remains until the device is placed or until another command or action is performed.

Now move the mouse pointer into the middle of the Editing Window and click left. An outline of the op-amp will appear under the mouse and will follow the mouse as you move it across the Editing Window. When you click left again the component will be placed and is drawn in full. Try this now and place the op-amp around the middle of the Editing Window.

![An outline of the component will follow the mouse in placement mode.](image)
Select the **MINRES1K** device and place one resistor just above the op-amp as in the section of the tutorial circuit shown above. Click left once on the anti-clockwise Rotation icon (shown below); note that the preview of the resistor in the Overview Window shows it rotated through $90^\circ$. Finally, place the second (vertical) resistor, $R_2$ as before.

![The Rotation icons with anti-clockwise rotation selected.](image)

You can also rotate parts 'live' when in placement mode. Left click the mouse once to enter placement mode (at this point you will see the component outline following the mouse) and then use the '+' and '-' keys on the numeric keypad to rotate the component as you are placing it. Left click again to commit the placement in the normal way.

Unless you are fairly skillful, you are unlikely to have got the components oriented and positioned entirely to your satisfaction at this first attempt, so we will now look at how to move things around. Positioning and orienting objects is one of the most common tasks in the editor and we have gone to great lengths to make this both intuitive and flexible. In ISIS, objects are selected for further editing by 'tagging' them.

There are several ways to tag an object in ISIS as detailed below:

- Choose the **Selection Icon** and then left click on the object. This is a standard technique found in most graphical applications and will tag any object. Bear in mind when using this technique that you must change back to component mode for example, when you wish to perform other actions such as placing components etc.

- Right clicking the mouse on an object will both tag the object and present a context menu containing available actions on that object.

- Simply left click on the object (note that the mouse cursor should be the selection cursor). This 'modeless' selection is an excellent shortcut for general use and will tag all objects except for wires (a left click on a wire will start placement of an adjoining wire) and 2D Graphics (a left click will start placement of a 2D graphic).

- Draw a tagbox around the object by depressing the left mouse button and dragging the mouse to form a box encompassing the object to be selected. This method will work for any object (or indeed sets of objects). Sizing handles are provided to allow you to resize the tagbox in the event that it does not fully enclose the object.

![A tagbox encompassing the op-amp.](image)
Similarly, you can clear a selection (or group of selections) either by left clicking in empty space or by right clicking in empty space and choosing the **Clear Selection** option from the resulting context menu.

![Clearing all selected objects via the context menu.](image)

When an item is selected it can be moved simply by depressing the left mouse button over the item (or inside the tagbox if you are using this technique), moving the mouse to the desired place and releasing the left mouse button. The mouse cursor will change to indicate when the item can be moved as shown below.

![Moving the selected op-amp.](image)

Alternatively, you can right click on the object and use the drag object action from the resulting context menu.

💡 Remember that you can rotate while moving by using the '+' and '-' keys on the numeric keypad.

This may seem rather involved at first reading but is extremely straightforward in practise. While we tend to find the modeless selection mechanism the easiest to work with your choice of working method should be one of personal preference. The following simple experiments will help familiarise you with the different techniques available and should help clarify your options:

1. Left click on the op-amp to tag it then depress the left mouse button over the op-amp and move the mouse to re-position the op-amp, releasing the mouse button at the point you want to place the object.
2. Right click on the (still selected) op-amp and select **Rotate Clockwise** from the resulting context menu to rotate the op-amp.
3. Use the '+' and '-' keys on the numeric keypad to rotate the op-amp back to its original orientation.
4. Left click in a free area of the schematic to deselect the op-amp.
5. Right click on the **MINRES1K** device and select **Drag Object** from the resulting context menu. Move the mouse (the outline of the resistor will follow the mouse) and then left click the mouse to place the object.
6. Right click on a free area of the schematic and choose the Clear Selection option from the resulting context menu.
7. Start at the top left of the **Editing Window**, depress the left mouse button and drag a box towards the bottom right of the **Editing Window** before releasing the mouse button. This will give you a tagbox and everything inside it will be selected.
8. Use the sizing handles to better position the tagbox so that it encompasses only the objects on the schematic.
9. Left depress the mouse inside the tagbox and move the mouse to move all the objects around at the one time, releasing the mouse when you want to place the objects.
10. Left click on an empty area of the schematic to clear your selection.
It is both easy and intuitive to select, position and orient devices in ISIS and, with a little practise, will become second nature. Armed with the above, experiment a little more by reworking the schematic such that the objects are positioned as in the screenshot at the top of this section ready for wiring.

**Wiring Up Components on the Schematic**

As with placing and positioning, wiring components is one of the most common tasks you will perform. As such, we have implemented wiring in ISIS with a view to making it as easy to use as possible. There are three main techniques used to achieve this:

- **Modeless Wiring**
  
  There is no ‘wiring mode’ in ISIS - wires can be placed and edited at any time, without the hassle of entering a dedicated wiring mode prior to placement. This means less mouse travel, less mode switching and quicker development.

  The exception to this is **Selection Mode** which, as the name suggest, will always select the object under the mouse. If in selection mode therefore, you need to switch modes once prior to wiring the design.

- **Follow-Me Wire Autorouting**

  After starting to place a wire, the proposed route of the wire will follow the movement of the mouse orthogonally to the termination point of the wire.

- **Live Cursor Display**

  The cursor will change as a visual indicator when wiring to show when a wire can be placed, when a wire can be terminated and when a wire is being placed.

We’ll see all of the above features in action as we wire the existing components on the schematic. Start by pointing at the tip of the upper end of R\textsubscript{2} (if you are currently in **Selection Mode** you will have to switch modes first) and note that the mouse cursor changes to a green pen to indicate that a wire can be placed here.

![Mouse cursor indicating that the mouse is over the pin tip.](image)

When the mouse cursor has changed click left to commence placing the wire. ISIS automatically senses that you are pointing at a component pin and deduces that you wish to connect a wire from it. The mouse cursor changes to an uncoloured pencil to indicate that wiring is in progress and the proposed route of the track will then follow the motions of the mouse towards the termination point of the wire, allowing you to see at a glance the topology of the wire as you route. This is an example of follow-me routing and it provides a transparent and easy way to quickly wire up the schematic. You can see this in action now by moving the mouse to the tip of the inverting input of the op-amp (reference the completed schematic in the previous section).

![Follow-me routing in ISIS](image)

For even more control of the wiring process we have introduced the concept of anchors during routing. Left clicking at any point during routing will place an anchor point (signified by a small cross on the route) thus committing the section wired to date before proceeding. This is an exceptionally useful tool when placing larger tracks or tracking around obstacles. Right clicks while routing will remove the previous placed anchor or terminate the wire placement if no anchors exist.
Note that you can override the follow-me routing altogether by simply holding down the \texttt{CTRL} key while placing a track this will suppress the routing algorithms and give you complete manual control.

Experiment with these techniques by doing the same thing for each end of \texttt{R1}, following the diagram at the top of the section. Familiarize yourself with anchoring and try tagging objects and moving them around whilst observing how the \texttt{WAR} re-routes the wires accordingly.

Follow-me routing in ISIS is both simple and intuitive but it is important that you are familiar with how to get the most of the functionality. In particular, the anchoring technique is invaluable with larger routes in getting the wire topology right at the first attempt. That said, if you do not like the route chosen by the wire auto-router, you can edit it manually after placement. To do this, tag the wire (by pointing at it and clicking right) and then try dragging it first at the corners and then in the middle of straight runs. If you want to manually route a wire you can do so by simply clicking left on the first pin, clicking left at each point along the required route where you want a corner, and then finish by clicking left on the second pin. After a while, you will get a feel for when the \texttt{WAR} will cope sensibly and when you will need to take over.

To complete this first section of the drawing, you need to place and wire up some terminals. Specifically, we need two generic terminals, a ground terminal and two power terminals. Start by selecting the \texttt{Terminal Icon} and note that the Object selector then changes to display a list of available terminal types.

Now place and wire up the Op-amp power rails. Select a power terminal, ensure its preview (in the Overview Window) shows it correctly oriented, and place it above pin 7 on the 741. As discussed previously ISIS is flexible enough to present you with several methods for editing parts - choose your preferred method for editing the terminal from the following:

- Double click on the terminal.
- Right click on the terminal to select it and launch the context menu and then use the Edit Properties menu option.
- Enter \textit{Selection Mode}, left click to highlight the terminal, then right click to launch it's context menu and use the Edit Properties menu option. Remember to exit selection mode when you are finished.

Having now launched the terminals dialogue form, type in +12V in the edit field as shown below and hit ok to exit the dialogue form.
Where appropriate you should always prefix numerical terminal values with a ‘+’ or ‘-’.

Wire the terminal to pin 7 of the op-amp and repeat the process for the negative power rail with another (rotated) power terminal, labelling it −12V and wiring it to pin 4 of the op-amp. Now place another the Ground terminal, ensure its preview shows it correctly oriented, and place it just under R2.

Next select the Default terminal from the selector and place two terminals as in the diagram, labelling them DAC1 and DAC2.

Finally wire the ground terminal to the bottom of R2 and the two default terminals to the corners of the wires going into the op-amp. ISIS will place the junction dots where required, sensing automatically that three wires are meeting at these points.

If you are unfamiliar with terminals and their usage we discuss them in far more detail in the section on Object Specifics in the online reference manual (Help Menu – ISIS Help).

You should now have a grasp of how to select, place, edit and wire parts on the ISIS schematic editor. We would imagine that most of the above is familiar to you to some extent from using other packages and obviously the more you use the package the more it becomes second nature. If you are finding it difficult to perform an action in ISIS a good basic rule to follow is ‘if in doubt, right click the mouse’. All objects in ISIS have a context menu which contains a list of legal actions at the point you launch the menu.
At this point our schematic should now look something like the following.

![The current state of the tutorial circuit.](image)

**PART LABELS**

You should see that all the parts you have placed have both a unique reference and a value. The reference is set by a feature of ISIS called **Real Time Annotation** which can be found on the **Tools Menu** and is enabled by default. Basically, when enabled, this feature annotates components as you place them on the schematic, saving you the time and effort of doing this manually.

You have full control over the position and visibility of part labels – you can change the values, move the position or hide information that you feel is unnecessary. The discussion below details how to manipulate part labels on a per component basis.

**Editing Part Labels**

If you zoom in on any resistor you have placed you will see that ISIS has labelled it with a unique Reference (e.g. ‘R1’) and also with a Value (e.g. ‘1k’). You can edit both these fields and their visibility via the **Edit Component** dialogue form. Launch this dialogue form now by double clicking the left mouse button over the resistor (or using one of the alternative methods discussed previously)

![The Edit Component dialogue displaying the component reference and it’s resistance.](image)

From the resulting dialogue form you can edit both the part name reference and, in this case, the resistance. Of more interest to us however, is the visibility options (highlighted in the above screenshot). It can be useful, particularly in densely populated schematics to hide some details displayed beside the parts – the trade off being that you would then need to edit the part as above to see it’s reference and value.

At this stage it is worthwhile familiarising yourself with editing components and hiding and showing references and values.

⚠️ **Some caution is required when changing part references in this manner. If, for example, you change ‘R1’ to be ‘R2’ then you will have two parts with the same reference on the schematic. This will cause problems later when netlisting through to ARES. We recommend that in practice novice users change annotation via the Global Annotator as discussed later in this tutorial.**
Moving Part Labels

As well as the ability to hide part labels you can move them to a more convenient place. This is commonly used where you might want to place a wire over the current position of the label and need to free up some screen space. We will try this now with the 'U1' and the '741' labels, moving them to correspond with the reference diagram.

The easiest way to tag the op-amp is to first change the snap setting. When the pointer is over the Editing Window, the increments of the co-ordinate display are in fixed steps - initially 100th. This is called snapping and enables you to position components and other objects on a neat grid. The degree of snap may be selected with the Snap Commands on the View menu, or directly via keyboard shortcuts.

Start by pressing F2 to reduce the snapping grid to 50th (it starts off at 100th) and then tag the op-amp. Now point at the label 'U1' and with the left button depressed, drag it to its correct position under the op-amp. Then do the same with the '741' label.

When you have finished positioning the labels, put the snap back to 100th by pressing F3. Although with the Real Time Snap feature ISIS is able to locate pins and wires not on the current snap grid, working consistently with the same snap grid will keep drawings looking neat and tidy.

Block Editing Functions

You may have noticed that the section of circuit you have drawn so far is currently located in the middle of the sheet, whereas it should be in the top left hand corner. Fortunately, ISIS provides an extremely easy and powerful mechanism to block move areas of the schematic.

First, depress the right mouse button and drag a box around the existing circuitry. This will highlight everything inside the box, indicating exactly what will be moved.

Note that the box has drag handles so that you can easily adjust the occupancy area (and therefore the objects) that will be affected by the block operation.

To move the items to the top left of the sheet position the mouse inside the tagbox (the mouse cursor will change to indicate that the items can be moved), left depress the mouse and drag the block to its desired position.
While not particularly significant in the above example, the fact that you can choose the 'pickup point' for dragging by depressing the mouse anywhere inside the tagbox is extremely powerful and is an enormous help when you want to position blocks of circuitry accurately.

Finally, left click the mouse outside the tagbox area to clear the selection and remove the tagbox. It really is that simple.

Performing a block copy, block rotate or block delete is equally intuitive. Start again by dragging a tagbox around the area of circuitry you want to perform the operation on. This time, instead of left depressing the mouse inside the tagbox (which would start a block move) simply right click the mouse inside the tagbox.

You should see, as in the screenshot above, that all the block operations are available to you. Feel free to experiment now with their operation - the effects of the operation can be cancelled by following their use with the Undo Operation (default keyboard assignation CTRL+Z)

The Block Rotate in ISIS is orthogonal and that you cannot rotate a block of circuitry containing sub-circuits or graphs (as these objects have fixed orientation).

PRACTICE MAKES PERFECT

You should be getting the hang of things now, so get some more practice in by drawing the next section of circuitry centered around the op-amp U2:A. as shown below:

The first op-amp filter section of the tutorial circuit.
Start by selecting the capacitor and the TL074 from the libraries using the methods detailed previously. For simplicity we will use ceramics for this design so you are looking for a ceramic 220pF capacitor. Use the various editing techniques that have been covered so far to get everything in the right place. Move the part reference and value fields to the correct positions.

When you have done one op-amp filter to your satisfaction, use a tag-box and the Block Copy context menu option to make another copy on the right. Notice that on the tutorial circuit, the two blocks are identical with the exception of some resistors.

Select the MINRES12k from the Object Selector, click left to enter placement mode and then move the mouse over the 15k resistor on the right hand block that we want to replace.

Selecting and moving the component over an existing component to perform a replacement.

Position the shadow outline of the resistor to be placed over the body of the existing resistor making sure to line up the pins and then left click to replace the MINRES15k with the selected MINRES12k while maintaining the existing circuit wiring. An advisory box will ask you to confirm the replacement. You can now do the same thing, replacing the 100k resistor with a 10k resistor.

Repeat this process with the lower two filters on the tutorial circuit (remembering to select a 1n5 Ceramic Capacitor from the library) so that you now have four filters in total corresponding to the tutorial circuit. As above, you will then have to replace resistors on the copied block to conform to the tutorial diagram.

When you have the four filters in position, wire them together, and place a SW-SPDT device (SW1) on the drawing.

You may find it useful to use the middle mouse button to zoom in and out so as to be able to see the whole sheet whilst performing the block operations and the wiring.

A very useful rule with elements like the TL074 is that you only need to wire the power pins on one element connectivity for the other elements is considered implicit thereby reducing clutter on the schematic. You can, if you choose, remove the power pins and wiring on the other elements such that the schematic is identical to the one shown at the start of the tutorial.

ANNOTATING THE DIAGRAM

ISIS provides you with four possible approaches to annotating (naming) components:

- **Manual Annotation** - This is the method you have already used to label the first op-amp and resistors. Any object can be edited by double clicking on it or via the objects context menu as discussed previously. Whichever way you do it, a dialogue box then appears which you can use to enter the relevant properties such as Reference, Value and so forth.

- **The Property Assignment Tool (PAT)** - This tool can generate fixed or incrementing sequences and assign the resulting text to either all objects, all tagged objects (either on all sheets or the current sheet) or to the objects you subsequently click left on. Using the PAT is faster than manual annotation, though slower than using the Automatic Annotator. However, it does leave you in control of which names are allocated to which parts.

- **The Global Annotator** - Using the Automatic Annotator leads to the whole design being annotated in a matter of seconds. The tool is aware of multi-element parts like the 7400 TTL NAND gate package and will allocate gates appropriately. However, the whole process is non-interactive so you get far less control over the names that are allocated than with the other two methods.
• **Real Time Annotation** - This feature, when enabled, will annotate components as you place them on the design, obviating any need for you to place references and values in your design. As with the Automatic Annotator, however, it makes the whole process non-interactive and offers no user control over the annotation process. Real Time Annotation can be toggled on and off through the Real Time Annotation command on the Tools Menu (default keyboard shortcut `CTRL+N`).

In practice you would typically use **Real Time Annotation** by default (as we have done in this design), and then use the Automatic Annotator or the **Property Assignment Tool** to alter the annotation if required for aesthetic reasons. The manual annotation mechanism is normally only used for multi-element heterogeneous parts (such as a relay and two contacts) where you need to specifically tell ISIS which contact belongs with which coil.

The use of multi-element heterogeneous parts is an advanced topic and beyond the scope of this tutorial. It is, however, discussed in some detail in the online reference manual (Help Menu – ISIS Help).

It is well worth our while to examine the other annotation mechanisms in more detail familiarising yourself with how these work will save you time later.

**The Property Assignment Tool (PAT)**

Let us suppose, for the sake of argument, that you wished to re-annotate some resistors from `R5` onwards using the (PAT). We therefore want to generate a sequence that starts at `R5` and increments (allowing us to annotate `R5`, `R6`, `R7`, etc..) To do this, select the Property Assignment Tool option on the Tools menu. Enter `REF=R#` in the String field, then move the cursor to the next field (the Count field) and key in the value 5. Ensure the On Click button is selected and then click left on the OK button or press **ENTER**. The hash-character (`#`) in the String field text will be replaced with the current Count field value each time the PAT assigns a string to an object and then the Count field value is incremented. This is shown below:

![The Property Assignment Tool set to Annotate resistors starting at R5.](image)

ISIS automatically selects the Selection Icon so that you can annotate the required objects by clicking left on them. Point at resistor `R7` for example and click left. The PAT re-annotates the resistor to be `R5` text and the part is redrawn. Now do the same for the old resistor which had the `R5` annotation, and see how the PAT's Count field value increments and annotates this resistor `R6`. You can now re-annotate the rest of the resistor references with some panache.

Try this on your own until you are clear about how the PAT works - although a little tricky at first, it is an extremely powerful tool and can eliminate a great deal of tedious editing.

> **Note that, as with manual annotation, you can re-annotate with the PAT such that you end up with two parts with the same reference (which will cause an error during netlist generation). A little discipline is therefore required in order to ensure correct annotation.**

> While not applicable here, the PAT can also be used to change values and indeed, any other component property; it is truly an invaluable time saving tool in schematic design. The dialogue form and some more examples are detailed here.
The Global Annotator

ISIS features a global annotator which will choose component references for you. It can be made to annotate all the components, or just the ones that haven't yet been annotated - i.e. those with a '?' in their reference.

The automatic annotator features two modes of operation as described below:

- **Incremental Annotation**: Annotation affects only those components within the specified scope (whole design or current sheet) that have not already been annotated.

- **Total Annotation**: All components within the specified scope (whole design or current sheet) are annotated.

With Real-Time Annotation enabled all elements except multi-element heterogeneous parts are automatically given a unique reference when placed. Since we have no parts of this type on the tutorial circuit we will run the Global Annotator in Total mode. To do this, invoke the Global Annotator command on the Tools menu, click on the Total button as shown overleaf, and then click on OK.

The Global Annotator in Total Annotation mode.

The diagram will be re-drawn almost immediately reflecting the new annotation.

⚠️ If you have a design which has already been netlisted to ARES and you want to re-annotate the schematic you should either apply the annotation changes to existing components in ARES and back-annotate or use the automatic annotator in Incremental mode. Using the automatic annotator in total mode should be reserved for pre-netlisting annotation as you fundamentally change the contents of the netlist by re-annotating everything!

CREATING NEW DEVICES

The next section of our tutorial circuit employs a 7110 digital attenuator, and this provides an opportunity to learn how to make new devices in ISIS.

In ISIS new devices are created directly on the drawing - there is no separate device editor mode, let alone a separate program. The new device is created by placing a collection of 2D graphics and pins, annotating the pins, and then finally tagging them all and invoking the Make Device command from the Tools menu.

You will find it helpful when creating new devices to sketch out on paper how you want the device to look, and to establish roughly how big it needs to be by considering how may pins there will be down each side and so on. In this case you can use the screenshot overleaf (showing a completed schematic part) as a guide.
**Drawing a New Component**

The first thing we need to do is to locate a free area of your design where the new device can be created - click the left mouse button on the lower-left region of the Overview Window to position the Editing Window on that area of the design.

**Re-positioning the schematic from the Overview Window.**

Begin by drawing the device body of the new device. Select the *Box* icon. You will see that the *Object Selector* on the right displays a list of Graphics Styles. A graphics style determines how the graphic we are about to draw will appear in terms of line colour, line thickness, fill style, fill colour, etc. Each style listed is a different set of such attributes and define the way different parts of the schematic appear.

**Displaying Graphics Styles in the Object Selector.**

ISIS supports a powerful graphics style system of local and global styles and the ability of local styles to follow or track global styles that allows you to easily and flexibly customize the appearance of your schematic. See the section *Graphics and Text Styles* in the online reference manual for a complete explanation of how styles work and how they are used.

As we are drawing the body of a component, select the *COMPONENT* graphics style, place the mouse pointer over the Editing Window, left click once, then move the mouse until the shadow outline forms a rectangle of the correct shape and left click again to place. Don't worry about getting the size exactly right - you can always resize the rectangle later. You will see that, as a result of choosing the *COMPONENT* graphics style, the rectangle appears in the same colour, fill, etc. as all the other components on the schematic.

The next thing to do is to place the pins for the new device. To do this, first select the *Device Pin* icon. The *Object Selector* lists the types of available pins (note that you can also create your own pin objects in ISIS, though we will not cover that in this tutorial). Select the Default pin type from the selector; the *Overview Window* provides a preview of the pin with the pin's name and number represented by the strings NAME and 99 and its base and end indicated by an Origin marker and cross respectively - the cross represents the end to which you will eventual connect a wire.

**Configuring ISIS for Pin placement.**

Use the *Rotation* and *Mirror* icons to orient the pin preview ready to place the left-hand pins and then click the left mouse button in the Editing Window on the left edge of the rectangle where you want each pin's base to appear. Place pins for the VIN, D0..D5, S1..3 and DGND pins. Note that you can use the down arrow key to move the mouse pointer down one grid square and then the *ENTER* key (twice) as a substitute for the left mouse button - it is sometimes quicker to use these keys instead of the mouse. Now click left on the Mirror icon and then place the three right-hand pins: RFB, IOUT and AGND. To finish, place two pins, one on the top edge and one of the bottom edge of the rectangle, adjusting the Rotation and Mirror icons before placing them in order that they point outwards from the device body; these pins will be the VDD and VBB power pins and will eventually be hidden (which is why they are not shown on the reference schematic part above).
While this tutorial will guide you through the basic process of creating parts with hidden power pins the topic is discussed in more detail in the online reference manual (Help Menu – ISIS Help).

At this stage, you can reposition the pins or resize the rectangle as required. To move a pin, tag it with the right mouse button and select drag object from the resulting context menu; to re-orient it, use the Rotation and Mirror menu items. To adjust the size of the device body rectangle, tag it by right clicking on the border of the graphic, then click and hold down the left mouse button on one of the eight 'drag handles' (the small black boxes at the corners and mid-points of the rectangle’s edges) and drag the handle to the new position. If you adjust its width, you will then also need to draw a tag-box around the pins and block move as discussed in the previous section to re-position them.

Selecting a graphic object requires you to click on the border of the object.

It is an important point that selection of 2D graphics objects (such as the component outline above) must take place by clicking on the border of the graphic as you may want to have composite graphics, or indeed to have a graphic object behind or in front of another object.

So, having arranged the device body rectangle and pins as required, we now need to annotate the pins with names and numbers, and to assign them an electrical type. The electrical type (input, power, pull-up, etc.) is used by the Electrical Rule Check to ensure that only pins with the correct electrical type are inter-connected.

We will first assign names, electrical types and visibility. Start by editing the first pin (at the top left) by clicking right on it and then selecting Edit Properties from the resulting context menu.

Launching the Edit Pin Dialogue Form in ISIS.

Now, using the completed part as a reference fill out the following information for the pin:

- Enter the pin's name in the Name field. Leave the Number field empty as we will assign the pin numbers with the Visual Packaging Tool later in the process.
- Select the appropriate electrical type for the pin - Output for the IOUT pin, Power for the VDD, VBB, AGND and DGND pins, and Input for the remainder.,
- Select whether the pin is to be hidden by unchecking its Draw body checkbox - the VDD and VBB pins are both standard power pins and can be hidden. The AGND and DGND pins are non-standard and so need to remain visible in order that they can be wired up as appropriate to the design the device is being used in.

Now, use either the PGDOWN key or the NEXT button to move to the next pin (you should see on the schematic that the next pin is automatically tagged) and repeat the process. Keep iterating through this process until all the pins are annotated as per the reference part and then click the OK button on the dialogue form to exit.
The VIN pin annotated and ready to move onto the next pin on the device.

What we have at this stage is a collection of graphics resembling the device we want. The final stage is to use the Make Device command to transform this into an ISIS library part.

**Making a New Device**

Start by tagging all the pins and the body rectangle - the easiest way is to drag out a tag-box with the left mouse button around the whole area. Then select the Make Device command from the Library menu to display the Make Device dialogue form. Key in the name 7110 in the Name field and the letter U in the Prefix field as shown below:

![The Make Device dialogue form with the name and device prefix entered.](image)

While outside the scope of this tutorial the prefix, 'U' in this case, is used to categorise parts for Bill of Materials output.

Select the Next button and then the Add/Edit button to add a packaging.

To add a package select the Add button at the top of the Visual Packaging Tool dialogue. In our case we want to add a DIL16 from the PACKAGE library. Find this footprint in the resulting footprint browser and double click on the footprint name to add the packaging to the device. The packaging tool should now look like the screenshot below.
The Visual Packaging Tool with a DIL16 ready for pin assignment.

The next stage is to add the pin numbers. You can just enter the numbers by hand in the A column but it is often easier (and more foolproof) to do this interactively. Start by clicking the mouse in the A column beside the AGND pin as shown above.

The AGND pin is pin 2 click the mouse on pad 2 on the footprint preview as shown opposite to assign. You should see the pad highlight, pin number 2 assigned to the AGND pin and the focus move to the pin field for pin D0.

Assigning pins interactively via the Visual Packaging Tool

You can now simply click the mouse on the appropriate pads (8 for D0, 7 for D1, etc.) on the footprint preview as per the reference device shown earlier. This will assign the pin numbers to the device when you are done the dialogue form should look like the following:

Visual Packaging Tool after assigning all pin numbers.
At this point all the pads on the footprint should be highlighted (providing visual confirmation that no silly mistakes have been made) and all you need do is click the Assign Packaging button and then the OK button to return to the Make Device dialogue.

You should now see the packaged footprint on the preview in the Make Device dialogue. Press the Next button until the Library Selection tab is displayed (the other tabs on the dialogue are optional and beyond the scope of this tutorial).

![The Make Device Dialogue Form on the Library Indexing Tab.](image)

At this point, you need to specify a category and sub-category for the new part. We would suggest Analog ICs and Miscellaneous, as above. You can also enter a textual description of the part and choose the library file that the part will be stored in, although in a typical installation, only the user device library (USERDVC) is writeable.

**FINISHING TOUCHES**

Now that you have defined a 7110 you can place and wire up the remainder of the schematic as shown below:

![Final Snapshot of the remaining schematic elements.](image)

The labelling and bracket around the six input terminals DA0-DA5 is done with 2D graphics. ISIS provides facilities for placing lines, boxes, circles, arcs and text on your drawings; all of which offered as icons on the Mode Selector toolbar.

The bracket is made from three lines - place these by selecting the Line icon and then clicking at the start and end of each line. Then place the text FROM PIO-1A as shown by selecting the Text icon, setting the Rotation icon to 90° and then clicking left at the point where to want the bottom of the ‘F’ character to appear. You can of course tag and drag 2D graphics objects around to get things just how you want.

Finally, you need to place a sheet border and a header block. These objects should be placed on the master sheet. This area is covered in detail in the templates tutorial but basically the contents of the master sheet are visible on
all sheets but editable only when the master sheet is selected. In a multi sheet design therefore (or indeed when starting a new design) these fields are visible, providing a consistent style and layout.

Full customisation of new design appearance and the construction of house styles is covered in the Templates tutorial.

Without covering a lot of theory therefore, to place the sheet border, goto the Master Sheet via the command on the Template Menu, select the Box Icon, zoom out till you can see the whole sheet outline (dark blue) and then place a graphics box over it. It is important to realise that the dark blue sheet outline does not appear on hard copy - if you want a bounding box you must place one as a graphics object.

To actually place the header, select the Symbol icon and then click left on the button of the Object Selector to display the Symbol Library Selector dialogue form. Picking symbols from symbol libraries is similar to picking devices from device libraries except that there is no Prefix selector. Select the HEADER object from the SYSTEM symbol library and close down the dialogue form. With HEADER now the current symbol, left click to enter placement mode, move the header into position and left click to place the header block.

We need to leave the master sheet and return to the design proper after placing these items. To do this go to the Design Menu and select our sheet from the bottom of the menu.

Some of the fields in the header block will fill in automatically; others such as the Design Title, Sheet Title, Author and Revision need to be entered using the Edit Design Properties and Edit Sheet Properties commands on the Design menu. Note that the Sheet Name field on the Edit Sheet Properties dialogue form is different from the Sheet Title - the Sheet Name is a short label for the sheet that is used in hierarchical design. The Sheet Title is a full description of the circuitry on that sheet and it is this that will appear in the header block.

You will need to zoom in on the header to see the full effects of your editing.

Note that, after naming the sheet title this is displayed at the bottom of the design menu. Particularly for complex multi-sheet designs, but also as general good practice, you should fill out the fields in the Edit Sheet Properties dialogue after usage.

As with the Master Sheet, discussion of configuration of the header block is outside the scope of this tutorial and is more of an advanced topic so don't worry if the above is slightly confusing at present! More information can be found both in the templates tutorial and here.

The Master Sheet is discussed in more detail in the Templates tutorial in the online reference manual.
SAVING, PRINTING AND PLOTTING

You can save your work at any time by means of the Save command on the File menu, and now is as good a time as any! The Save As option allows you to save it with a different filename from the one you loaded it with.

To print the schematic, first select the correct device to print to using the Printer Setup command on the File menu. This activates the Windows common dialogue for printer device selection and configuration. The details are thus dependent on your particular version of Windows and your printer driver - consult Windows and printer driver documentation for details. When you have selected the correct printer, close the dialogue form and select the Print option on the File menu to print your design. There are a number of options available on this dialogue form, all of which have context sensitive help and are also discussed in more detail in the reference manual under Hard Copy Generation. For our purposes we will simply center the schematic output on the page and print. Do this now by right clicking on the Print Preview and selecting the Position Output at Center option as shown below.

More About Creating Devices

Making a Multi-Element Device

We shall now define a proper library part for the TL074 quad op-amp. As there are four separate op-amps to a single TL074 package our tutorial will be showing you how to create multi-element devices using the Visual Packaging Tool.

The illustration above shows the new op-amp device before it is made. The op-amp is made from some 2D graphics, five pins and an origin marker. While we could draw the graphics from scratch (as per the previous 7110 example) the easiest approach to creating the op-amp graphics uses the pre-defined OPAMP symbol. Proceed as follows:

- Click on the Symbol Icon and then click the P button at the top left of the Symbols Object Selector. This will launch the Symbol Library Selector dialogue form.
- Double-click on OPAMP in the System Library and close the dialogue form using the Windows Minimise button on the right of the title bar.
- Position the mouse pointer in an empty area of the Editing Window and use the left mouse button to place the op-amp. The op-amp automatically appears in the COMPONENT graphics style as this style was used to create the symbol.
Now place and edit the pins around the component body. This is the same process as for creating the 7110 attenuator earlier:

- Select the Device Pin icon to obtain a list of available pin types and select the Default type.
- Use the Rotate and Mirror icons to orient the pins before placing them on the design.
- Place the pins as per the reference screenshot on the op-amp graphic. The power pins have the names V+ and V- and have the electrical type of POWER; if you place them just in from the left edge of the op-amp, you will find they just touch the sloping sides of the OPAMP graphic whilst keeping their pin ends (marked by an 'x') on a grid-square. If in a similar situation, they didn't touch, you could 'extend' the base of the pin by placing short lines using the 2D Graphic line icon and with the mouse snap off. The input pins have the names +IP and -IP and the electrical type INPUT. The output pin has the name OP and the electrical type OUTPUT.
- Edit the pins as before, naming them but not numbering them (this is done via the Visual Packaging Tool). We have to give the pins names so that we can reference them in the Packaging Tool however, we don't want the name to be displayed (as the op-amp pins' uses are implicit from the graphics) so ensure that the Draw Name check-box is not checked.

The final stage is to place an Origin marker. Select the Marker icon to display a list of system marker symbols in the Object Selector. Select the Origin marker and then place the marker symbol at the centre of the op-amp graphic. The Origin marker is displayed as a rectangle with cross-hairs and it indicates to ISIS how the new device should appear around the mouse pointer when the device is dragged or placed in a design.

We have now completed making the device. Tag the constituent parts - the op-amp symbol, pins and the Origin marker - by dragging out a tag-box around them using the left mouse button, and then invoke the Make Device command on the Library menu. Then proceed as follows:

- Enter the Device Name as TL074 and the Prefix as 'U'
- Click the Next button display the Packaging page and click Add/Edit to launch the packaging tool itself.

**THE VISUAL PACKAGING TOOL**

The Visual Packaging Tool provides a graphical environment in which to assign one or more PCB footprints to a schematic part. For each packaging, a table of pin numbers to pin names is created such that different packagings can have different pin numbers for the same schematic pin.

Having launched the packaging tool, the first thing to do is to create a packaging:

- Click the Add button. This will launch the ARES library browser.
- Select the PACKAGE library, and double click the DIL14 part.

Then, you need to make the following changes to the default settings for the packaging:

- Change the number of elements from 1 to 4. This corresponds with the fact that there are four Op-amps within the one physical DIL14 package.
- Mark the V+ and V- pins as common pins. This means that they will have the same pin number on each element, and that you can wire to any or all of the pins on the elements on the schematic. All such wiring will be deemed interconnected.
- Click the Gates are Interchangeable checkbox. This specifies that the elements are identical and the ARES can perform gateswap operations on this part.

You should then see a display similar to that below:
The Visual Packaging Tool ready for Pin Assignment.

Now to assign the pin numbers. The actual pinning of the op-amps that we are aiming at is shown below:

The four elements of the TL074.

Proceed as follows:

- Click left in the ‘A’ column box for pin +IP.
- Either, click pin ‘3’ on the package display or enter ‘3’ from the keyboard and press TAB. Either way, pin ‘3’ will highlight on the package to show that you have assigned it, and the cursor will move to the –IP row.
- Now, repeat the process for the other pin numbers, until all the pins on the package display are highlighted. This of course, provides a visual cue that you haven’t missed any pins.

Finally, click the Assign Packages button to return the Make Device wizard, and then store the device into your USERDVC library, as you did with the 7110.

There is, as you have probably realized, a great deal of functionality build into the packaging tool. For a detailed discussion and further examples, see Device Libraries.

Making Similar Devices

Having defined a TL074, you can almost instantly define types TL064 and TL084 as well. Simply place a TL074, tag it, and invoke the Make Device command; change the name to TL064 (or whatever) and save it. What could be simpler? If you needed to add something to the basic TL074 - perhaps some more graphics, you could simply add them on top of the placed TL074 before invoking the Make Device command.

Replacing Components in a design

You can now replace the four filter op-amps and with proper TL074 parts. To replace a component with one of a similar type, pick the new device, ensure the mouse is over the device you want to replace, click and hold down the left mouse button and drag the new device such that one or more pin-ends overlap. ISIS will then transfer the wires from the old component to the new component whilst keeping all other information about the old component (e.g. its reference, etc.) intact.

SYMBOLS AND THE SYMBOL LIBRARY

Tag the three lines that form the bracket around the inputs to the 7110. Then invoke Make Symbol command on the Library menu, key in TEST for the symbol name and press ENTER. Now select the Symbol icon. You will see that the item TEST has appeared in the Object Selector. Pick this and try placing it on the drawing. Common uses for this are things like OPAMP, which is needed for many device types, and logos, emblems etc.

A special use of symbols is for the HEADER block which we covered in brief earlier and is both detailed fully in the online reference manual (Help Menu – ISIS Help).
THE DESIGN EXPLORER

ISIS provides a powerful tool for navigating and examining a schematic in the form of the Design Explorer. This is an extremely complex and versatile tool which is discussed in detail in the reference documentation but we will use this section to provide you with a flavour of the types of things it can be used for.

Start by launching the Design Explorer from the Tools menu (default keyboard shortcut 'ALT+X'). The design explorer will launch in what is called 'Physical Partlist View' and display a listing of all the components used in the current sheet (displayed on the left hand pane).

In our tutorial design we only have one sheet but in a larger design we could use the left hand pane to navigate through the sheets, viewing the component parts on the currently selected sheet.

The Design Explorer launched on the tutorial design.

Straight away we can see that our switch has no package associated with it (the red text missing under the package column), which would be a problem were we to proceed to ARES for PCB Layout. A quick, visual check of the circuit to identify silly mistakes like this therefore takes a matter of seconds with the design explorer and can save considerable time at a later stage.

We can use the design explorer to quickly locate a part (or indeed a net or sheet) via the find icon at the top of the explorer window. Try this now, locating the C4 Capacitor by typing in C4 in the find dialogue and then using the ISIS icon at the top of the explorer to zoom and navigate to the component.

Using the Design Explorer to locate and navigate to a component.

The design explorer is a top level, modeless window - it minimises to the system tray when you use it for schematic navigation to preserve screen real estate. You can, of course, maximise it again in the normal way and continue design verification/interrogation.

We can also use the design explorer to check connectivity. Find and double click on part 'U3' on the right hand pane - the design explorer will change views as shown below, with a listing of all the pins on part U3 now displayed on the right hand pane, while a listing of all the components on the sheet is shown on the left hand pane.
The Design Explorer displaying all pins on part U3.

If we now right click for example on U3-VIN the resulting context menu will allow you to Goto Schematic Net. This provides an excellent visual method of quickly verifying connections on a net.

Highlighting the net connected to VIN on the schematic via the Design Explorer.

Note that, as well as via the ISIS icon, you can also navigate to the schematic part (or indeed the schematic sheet) via this context menu.

Alternatively we can simply double click on the pin in question within the design explorer. This shortcut actually switches the design explorer from 'Physical Partslist View' to 'Physical Netlist View' and gives you a 'live' view of the connections on the schematic. Since we activated this from a pin on U3 what we see on the right hand pane is a list of connections on the net connected to that pin. An extremely simple and powerful way to examine connectivity!

The Design Explorer displaying the connections on the net connected to the VIN pin of U3.

It's worth taking a moment to summarise what we are seeing at present. The left hand pane displays a list of nets, where there are separate icons both for global nets and for single pin nets (extremely useful in itself). We are now in netlist view rather than partslist view meaning that we are looking at a list of nets rather than a list of parts.
The Design Explorer currently in Netlist View.

The clever part here is that the pins are the common link between the netlist and the physical component. Double click on a pin in netlist view and you will switch to partslist view, with the right hand pane showing all the pins on that device. Try this now with the **SW1-COM** pin displayed in the right hand pane.

The Design Explorer currently in Partslist View.

What we are looking at now is a listing of pins on the **SW1** component in partslist view. Similarly, if we now double click on the **SW1-NO** pin we will see all pins connected to this pin in Netslist View.

The Design Explorer in Netlist View showing all pins connected to **SW1-NO**.

You can directly switch between netlist view and physical view at any point via the icons at the top left of the design explorer.

In the examples to date we’ve started from a physical component and then used pins to examine connectivity (either in partlist view to see the pins on a device or in netlist view to view the connections to a physical pin). We can, in cases where we know the net (**GND** being the obvious example) bypass this and directly examine all the connections on a particular net. Simply switch the design explorer into netlist view, left click on the sheet to display all nets and then click on the **GND** net on the left hand pane.

The Design Explorer in Netlist View showing all connections to **GND**.

The design explorer is capable of far more than we have discussed here but such functionality exceeds the scope of this tutorial. More information can be found in the sections on Cross Probing and also in the main Design Explorer section of the reference manual.
REPORT GENERATION

Now that the diagram is complete, you can generate Netlist, Bill of Materials and Electrical Rules Check reports from it. Each report is generated by invoking the appropriate command from the Tools menu. The report output is displayed in a pop-up viewer window from where it can be saved to a file by selecting the 'Save as' button or placed on the clipboard for use in other packages using the Copy to clipboard button;

The Bill of Materials report should be fairly self explanatory, although you can get a lot more out of the facility – see the online reference manual under Report Generation for more information.

The Electrical Rules Check report will contain quite a few errors, since the tutorial circuit is not a complete design, whilst the Netlist Generation deals in the intricacies of producing and using a netlist. For those of you who have bought ISIS to use with ARES, details of how to link the two packages together are provided in practical format in the accompanying ARES Getting Started Guide as well as being discussed in detail in the online reference documentation.

A LARGER DESIGN

In this last section, we shall take a look at a pre-prepared design - EPE.DSN. This is a multi-sheet, hierarchical schematic for micro-processor controlled EPROM programmer/emulator (EPE). As such, it represents a substantial piece of electronics at the lower end of design complexity that you might expect to design with your ISIS system.

The EPE design is structured as three A3 sheets (Processor, Emulator and PSU). Sub-sheets are used to represent an Emulation RAM bank (of which there are 4, giving 32 bit emulation capability) and a Programmable Power Supply (PPSU) of which 6 are required to deal with the range of 27 series EPROM pinouts.

Open the design in to ISIS by using the Open Design command on the File menu, and then selecting EPE.DSN from the file selector. You will find it in the "Samples\Schematic & PCB Design" folder of your Proteus installation. Alternatively, you can view any of the sample designs by launching the SAMPLES help file from the Help menu.

The first sheet is the CPU - take a look round this with the usual pan and zoom facilities. Then, to see more of the design, invoke the Design Explorer and navigate as discussed previously,

You can also zoom into the sub-circuits: point at one of the sub-circuits and press the shortcut key for Zoom to Child (by default this is CTRL+C). ISIS swaps out the Emulator Control sheet and loads an ERAM bank sheet. Take a look round the ERAM bank circuit and in particular, take note of a few of the component numbers. To get out, press the shortcut key for Zoom to Parent (default assignment is CTRL+X). Now that you know about loading the various sheets and hierarchy roaming you may as well explore the rest of the EPE design.